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Open Microsoft Word 2007
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Saving your
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Saving your Document cont’d

* When you save a document in MS Word 2007, it automatically saves with
“.docx” as its extension.

* However, you can also save your document so that it’s readable by earlier
versions of MS Word (97 — 2003) by simply selecting “Word 97-2003
Document (*.doc)” when choosing what file type to save as (please see the
screenshot below)

e For Al, please save your documents as “.doc” and not “.docx”

[.r_’] File name: Docl.docx
e
p S&we 35 LYPE! | word Document (%, docx)
Word Document U, docx)
‘Word Macro-Enabled Docurment (%, docm,
20ls T| Word 97-2003 Document (¥, doc)
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Word Macro-Enabled Template (. daokm)

Word 97-2003 Temnplate (*.dok)




Getting Help in MS Word 2007 .

€@ Word Help =i

 To get help in Word CICICICE-IL 1L X -

2007, look for the help
icon [ ¥/ ] in the top
right-hand corner of the
screen and click on it.

* You will be presented
with a window that
looks like the one here
on the right.

Converting documents
Margins and page setup
Page numbers

Writing

Tables

Tables of contents and other
references

Sawing and printing
File management
Accessibility

Working in a different language

Tracking changes and comments

Browse Word Help
What's new Activating Word
Getting help Creating spedfic documents

Viewing and navigating

Headers and footers

Page breaks and section breaks
Formattng

Lists

Warking with graphics and charts

Mail merge

Collaboration
Customizing
Security and privacy

Automation and programmability

Al vwward
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MS Word 2007 is organized into tabbed
menu bars, like the one you see here at
the top of the screen.

By default, MS Word 2007 starts you off
in the Home tab when you first open the
program.
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* From here you can change the size [ll "],
colour [ A ], font [caisimean ], Style [":‘fibﬁ“]
and justification of text [ = == ]. As well,
you can also add highlighting [ 2% ], shading .

into a bulleted [;: ] or numbered [i= ] list.

e There are many more options, so explore and find out what’s
available! And, if you don’t know what something is, just hover
the mouse over to find out!
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Header & Footer Text

A textbox can be placed anywhere on the page,
giving you much more control of how your
document will look (this is especially useful for
putting text around a pictures)

To insert a textbox, go to the insert tab and click
on the text box button

Drag mouse pointer over an area to create
textbox

You can enter text into a textbox and control its
formatting (alignment, font, etc). You can add
formatted text to almost all drawing objects

Textboxes can be removed and resized exactly
like every other drawing object in Word
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e WordArt allows you to j J 5] Quick Pats ~ (2 Signsture Line ~ | T Equstion -
add interesting text . = biiae] oseatine |0 sneol~
effects into your ur| Worelant woert wordar, Worddfl Woraart ; VT
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design.
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e To insert arrows,
callouts, and other
shapes go to the insert
tab, click on the Shapes
button and select the
shape that you want to
insert.

 Note, shapes are not the
same thing as symbols!
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* A calloutis similar to how a dialogue is shown in a
comic book

 Toinsert a callout, click on Shapes from the insert
tab and find the type of callout you’'d like to insert

 Next, drag a box over the area you want the callout
to appear in and type some text into the callout
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 To create a 3-D shape,
first insert an a shape
from the insert tab

e When you have done
that, you will be
brought to a format tab
for your shape that you
can then use to change
your shape into a 3-D
shape.

3-D Shapes
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SyMBOTS ™

 Symbols can be inserted
from the insert tab and
include things like the
greek alphabet,
mathematical notation,
etc...

e Also, if you click on “more
symbols” you will get a
chart like the one on the
right with many, many
symbols

are Line - JC Equation -
Time |£1 Swmbol =
- £ £ 4 =
e + # < =
= o o ' |
B m O )
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Columns

e Toinsert columns into your 1:33 e :
/4

document, go tO the Page et Home Inzert Fage Layout Fefere
3 : : .__-I -
Layout tab, select “Columns”, Aaj Fa- | -3 Orientation = = Breaks
== [a]- [ Size £ Line Mur
then select the number of Themes Marging o= .
] . - ' - EE Columns = ke Hyphens
columns you‘d like to split your Themes

document into. =

e

e Or,if youdon’t want your - Twe
whole document broken up
into columns, you can highlight =
some specific text that you’d et
like to break into columns and
then select the number of = B
columns.
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Columns (cont’d)

e Or, you can choose “More
columns” and a dialogue box
such as this one will pop up
giving more control over the
columns.

* From here you can change;

— the number of columns

— Whether or not there is a line
between columns

— The width & spacing between
columns

— How long you want the columns to

last, as in a whole document, or
just a section

Presets
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Using Tables

!rn@ H92-0 )+
() TO |nsert a ta ble' go to - Home Insert Page Layout References Mailings
the insert tab and look | |- T EEAVR =" I
Tahle

__] Blank Page
for the Table button *%F‘age S Picture Cllr:u ShELpes Smartit Chart e
Fages 6x6 Table

[ i 5 o
* You can;peclzlfy the %E%E
r(?WS ana co ymns | .
either by typing them in %E%E
or by drawing the table. N000000000
y 5 N

j Insert Table,.,

_-ﬁ Diraws Table

:—Fﬁl Excel Spreadsheet
0 Quick Tables >




Table Formatting

Tables are made up of rows and columns
Columns/rows are resized by dragging its border
A cell is one element (‘box’) in the table

Each cell can have different colours, sizes, etc

Row, column and cell properties can be changed
by right-clicking or
through the Table
menu option

I S R N

YES

YES

YES




Cross Referencing

In MS Word 2007, cross referencing
can provide a direct link to a figure,
table, equation and more.

To insert a cross reference, go to the
References tab and click on “Cross
Reference”.

Next, select the type of reference to
add (a page number, paragraph,
etc...) and what you’re referring to (a
heading, a numbererd item, a
footnote, an endnote, etc...).

Note, the location of the cursor in
your document is the location where
the cross reference will be inserted.

Cross-reference

Reference bype:

Insert as hvperlink.

Far which numbered item:

crosoft Word

Add-Ins
& [ Insert Table of Figures ﬂq}: EN
¥ Update Table =l
Insert Mark
Caption | H] Cross-reference Entry
Captions In

Cross-reference

Refer to items such as headings,
figures, and tables by inserting a
cross reference such as, "See Table
6 below™ ar "Turn to page §."

Cross references are autormatically
updated if the content is mowved to
another location. By default, cross
references are insetted as
hyperlinks,

?X

* | |Page number w

[ tncude abovefbelow

Insert reference to:

Cancel




Styles

e Styles are predefined settings font, size, colour, etc... for text.

e For example,

— “Normal” default style in MS Word 2007 is 11pt, Calibri
font, black text.

— “Heading 1” is 14pt, Cambria font, navy blue text

e Also, if you don’t like the way a particular style looks, you
can change it simply by right-clicking on it and selecting

o . V4
Modif
Y ‘mabcm: 23BbCeDe AaBbCi AaBbCc %

% Tror Update Mormal to Match Selection — Change
; Styles =
AaBbCeDe|| 2aBbCeDe AaBbU: AaBbCc Nt Modifye, :
THoarmal | TMoSpaci.,, Headingl Heading2 = Change
Shyles =
Styles i Rename...

Fermowve fram Quick tyle Gallerny

Add Gallery to Quick &ccess Toolbar




Inserting A Table of Contents

To insert a table of contents,
you first need headings (recall
from the last slide, headings
are styles applied to text and
are not to be confused with a
header, which is a special
section at the top of your
document).

Next, from the references tab,
click on Table of Contents and
insert an appropriate table or
choose the “Insert Table of
Contents” option. —

(Oa) d 9 - v
— Home Insert Page Layout References
2 Add Text - |y Insert Endnate
= =¥ Update Tahle -‘tg Wext Footnote =
Table af Insert . o
Contents - Footnote = >how Mote
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Rewienw Wiew

L} Manage Sources
(3 Stile: apa,

Citation - 4 Bibliography =

Built-In
Automatic Table 1

Contents

Heading 1
Heading 2

Haading 3

Automatic Table 2

Tahble of Contents
Heading 1

Headlng 2

Heading 3

Manual Table

Tahle of Contents

T e P e e s e it s i i o b0 s i st oo T sl

Ty pe chyapber BEe Elmas] 3 i i i e T i iyl i i b e

Type chapter title (level 1] .

$ | InsertTable of Contents..

Bl

[,  Remowe Table of Contents

s W R e
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Inserting Pictures

e Pictures can be inserted in a number of ways.
For example:

— You can simply cut and paste your image into your
document

— From the insert tab you can insert clipart

— From the insert tab you can insert a picture from
a file on your computer q.

Home

=] Cover Page = | |
_] Blank Page

P,_—: Page BEreak

Pages Ilustrations

References kailings

U e




Captions

 Toinsert a caption for an

Image:

— You can right-click on the
image and choose the
“insert caption” option

Change Picture...

— Or select “Insert Caption”
from the references tab e ek

3| Insert Caption...

i Insert Table of Figures % ::ﬂrappmg

! Update Table .

Caption ] Cross-reference

Captions




Inserting A Table of Figures

Inserting a table of figures is very similar to
inserting a table of contents, except instead of

listing headings, a table of figures lists
captions.

To insert a Table of Figures, go to the
References tab and select “Insert Table of

Figures”.
ﬂ = Insert Table of Figures

Insert
Caption "] Lross-reference

Captions



Section Break, Page Break, What the...?

e Section Breaks are different than standard
page breaks

— Standard page breaks simply insert a new page

— Section breaks may do this, but don’t necessarily
do so

e |nstead, a Section is an invisible division
within your document



What Are Sections Used For?

e Sections are primarily used for formatting

e |f you want the formatting to apply across an entire
document, then you don’t need sections

e But, if you want to change the way page numbers
are displayed (for example), then you need to use
section breaks

— Section 1 may contain the Table of Contents, with no page
numbers; while Section 2, contains the Table of Contents
and Table of Figures with Roman Numeral Page numbers;
and Section 3 contains the rest of the document with a
regular good old number set (1, 2, 3..)



Types of section breaks

Section breaks keep the formatting elements like
margins, page orientation or sequence of page
numbers (more on this to follow)

Next page inserts a section break and starts the new
section on the next page.

Continuous inserts a section break and starts the
new section on the same page.

Odd page or Even page inserts a section break and
starts the new section on the next odd-numbered or
even-numbered page.

To do a section breaks, click on Insert and Break



Using Section Breaks

e So, Section Breaks are used to divide your
document up into different formatting sections

— As an example, the first section might have roman
numeral page numbering and the second section
might have regular page numbering (or no page
numbering at all).

e |n particular, the “Next Page” section break is very useful
in this purpose since it starts the next section at the top
of the following page.



Using Section Breaks (contd)

= Breaks = A watermark = Indent

e Toinsertasection . e | s

EE Columns ~ Page
kark the point at which one page ends

break, go to the
Page Layout tab.

When you click on
“Breaks” you will be
presented with a list »
of breaks.

Insert a section break and start the new
section an the same page,

k

Column

Indicate that the text following the column
break will begin in the next column,

Text Wrapping

Separate text around abjects on weh
pages, such as caption text from body text,

‘ % “Il]h—l: _L,L

Mext Page
Insert a section break and start the new
section an the next page,

ol

‘|'

 Note, the location of the cursor in
your document is the location
where the section break will be
inserted so be aware!

Even Page
Insert a section break and start the new
section an the next even-numbered page,

IEE |

Odd Page
Insert a section break and start the new
section an the next odd-numbered page.

BE
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Header and Footer e oo oo

i w Mumber -
Header & Footer

e Headers and footers are typically used in printed documents
that include text like page numbers, date, etc...

e Headers are printed in the top margin and footers are
printed in the bottom margin.

e From the Insert tab, click on either Header or Footer and
you will be prompted with the type of header you’d like to
work with. Choose any of the appropriate styles, or simply
click on “Edit Header” or “Edit Footer”, and you will be given
a new menu bar with header or footer specific options.

, H9-48 = Documentl - Microsoft Word Tahle Tools Header & Footer Tools
3
st Horme Inszert Page Layout References Mailings Rewiews Wie Add-Ins Cresigh Layout Design
':'j ] ] - il _ﬂ Previows Section Different First Page j* Header from Top: n.5"
= - . = — _'I_'!; Mext Section Different Odd & Ewen Pages ::1‘ Footer from Bottom: |0.5"
Header Footer Page Date  Quick Picture Clip soto Goto
- Mumber~ || & Time Parts = ot Header Footer /| Show Document Text

Header & Footer Insert Mavigation Options FPosition

Ak |4k



A Bit More on Headers and Footers

 To manually set the header or footer of the current
section to something different than the previous
section you need to go to that section, click on
header or footer from the insert tab and then make
sure that “Link to Previous” is deselected.

Documentl -

icrosoft Word Header & Footer Tools

BFEFICES Mailing Fewigws ol ey Add-Ins Design

Ellgl —:r j. Previous Section Different First Page 34 H
4 p Mext Sedtion Different Odd & Even Pages || it Fe
Clip Gotao 1,3

At Header '%51 Link to Prewious V| Showe Docurnent Text ﬂ In

Mavigation Options

Link to Previous

Link to the previous section so that
the header and footer in the
current section contain the same
content as in the previous section,

i€ Press F1for more help.




Page Numbers

e To add page numbers to a
document, do the
following:

— If you would like to have
different styles of page
numbers, first use a section
break and then click on the
section you want to insert
page numbers into.

— Once you are ready to put in
the page numbers select
“Page Number” from the
insert tab, then you will be
given some more options

Microsoft Word

Header&ﬂ_ﬂ__

IE
|
4

o
=

Top of Page
Bottom of Page
Page Margins

Current Position

| 57" Eormat Page Mumbers..,

Eemowve Page Mumbers

[

[&
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:|1| _] j A | Quick Parts
: = #
' =3 Al wiordart -
Header Footer | Page Text o
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Page Numbers (contd)

This lets you change the number style (i.e.
o If you want to format Roman Numerals, Letters, etc...)

your page numbers,
select, “Format Page
Numbers”, otherwise,
select where you’d like
to insert the page
numbers into and

Page Humber Format

Mumber Format: |1, 2, 3, ..

[ ] include chapter number

p roceed . Page nurnbering
Change this option if you wish to () Continue from previous seckion
start again from 1. Select start at () Start at: |1 e

and give a page number to begin
counting from (1 is usually your
best choice). Ok | | Cancel




The Most Important Feature

SPELLCHECK !

e MS Word 2007 provides you with many tools
for spelling and grammar and these can be
found in the Review tab!

e [t’s important to note though that even if Word
catches all your spelling mistakes it may miss
bad grammar — proofread it yourself, too!

(eg: Your is car instead of Your car is)

j-;ﬁ‘ Research ji,* | | __2), _] '_'_, Final Showing Markup = Qﬁf}’ -_3} Reject = ]
W : = - 3 Previous ——

450 Thesaurus = 1 =] Shows Markup -
Lpelling & T P et Track  Balloons o Accept Compare
Grammar ig Tranzlate a5 COmmen t o Changes = - ._E Reviewing Pane - - %J} Mext -

Proofing Camments Tracking Changes Compate



Final Notes

e Practise, Practise, Practisel!!l
e |If you have any problems post in the forum



	Microsoft Word 2007 Tutorial
	Open Microsoft Word 2007
	Saving your Document
	Saving your Document cont’d
	Getting Help in MS Word 2007
	Home
	Textboxes
	Shapes
	Callouts
	3-D Shapes
	$ÿМβΘζЅ ™
	Columns
	Columns (cont’d)
	Using Tables
	Table Formatting
	Cross Referencing
	Styles
	Inserting A Table of Contents
	Inserting Pictures
	Captions
	Inserting A Table of Figures
	Section Break, Page Break, What the…?
	What Are Sections Used For?
	Types of section breaks
	Using Section Breaks
	Using Section Breaks (cont’d)
	Header and Footer
	A Bit More on Headers and Footers
	Page Numbers
	Page Numbers (cont’d)
	The Most Important Feature
	Final Notes

